ROBOCODE - UN MEDIU MULTI-AGENT

SI O SANSA SA INVATATI JAVA ©
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Introducere
= Robocode este o platforma multiagent in care

este simulata o lupta.
A fost dezvoltata de catre Mathiew Nelson de la IBM in

2001.

= Estescrisin Java
Initial s-a dorit a fi o unealta de invatare a Java
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A devenit rapid un joc la nivel mondial
si 0 unealta de cercetare a inteligentei artificiale

** Creezi un robot printr-un program Java, il arunci .
_ _ L
in campul de bataie unde lupta pana la sfarsit cu %

oti creati de alti programatori. =




Scopul acestui curs

= Creati-va propriul robot.
Dati-i miscari mecanice... apoil...
Oferiti-i inteligenta artificiala!

= Robotul poate fi ghidat de:
Algoritmul minimax
2 Invatare reimprospatata

¥

= Aduceti-va robotii pe acelasi camp de lupta!
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Instalarea Robocode
= |nainte de a instala Robocode, aveti nevoie de Java

(JDK) :
http://java.sun.com/javase/downloads/index.jsp

= Pentru Robocode, descarcati de la pagina :

http://sourceforge. net/prOJects/robocode/flIes/robocod
e/1.9.2.4/
sau unul mai recent daca exista.
= Daca ati instalat JDK, puteti da
%bblu-click pe

robocode-1.9.2.4-setup.jar

stalarea.



http://java.sun.com/javase/downloads/index.jsp
http://sourceforge.net/projects/robocode/files/robocode/1.9.2.4/
http://sourceforge.net/projects/robocode/files/robocode/1.9.2.4/robocode-1.9.2.4-setup.jar/download

Lansarea Robocode

» | ansati Robocode de la shortcut-ul de pe Desktop.

= Pentru a crea un robot,
selectati din meniu “"Robot”,
apoi “Editor”. Se deschide o
fereastra, unde mergetila
meniul “File”->"New"->"Robot"

## li puneti un nume, apoi va
va cere sa ii dati initialele (la




E Robocode
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Robot Editor
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After trying out - ., LY wncommenting the import at the top
ard

Jblue, Color. green) ;

lines with any behawvior you would like
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= Nu vitati sa salvati codul (din meniul File) si sa
ilati (din meniul Compiler)!
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Cum ajungem in arena?

Selectati meniul Battle.

Alegeti robotii pe care vreti sa ii antrenati
intr-o batalie (inclusiv al vostru).

= Daca robotul vostru a supravietuit bataliei,

ati castigat runda.

E Robocode: Turn 149, Round 6 of 10, 12 TPS, 13 FPS
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Ce poate face un robot

Robotii simuleaza tancuri intr-o arena de lupta si,
pentru a detecta alti roboti, sunt echipati cu radare.

Un robot poate merge inainte si inapoi cu diverse
viteze si se poate intoarce la stanga si la dreapta.

Radarul si tureta se pot intoarce la stanga sau dreapta,
fiecare independent si, in acelasi timp, si de restul
tancului. Arma poate, bineinteles, trage.
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Cand un robot inamic apare pe radar, un eveniment
«+¥ Java este generat si se pot genera diverse actiuni.
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Ce informatil se pot obtine

= Putem lua informatii despre robotul inamic
detectat in ceea ce priveste:

Viteza sa

Modul in care este indreptat

Energia ramasa

Numele (R

Unghiul dintre orientarea propriului robot si
robotul inamic detectat 250

Distanta pana la acel robot
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Campul de lupta

= Estereprezentatintr-un plan bidimensional si este
imprejmuit de ziduri.
= O pozitie din campul de lupta este data de coordonatele
(X, Y)
Originea (o, 0) este plasata in coltul din stanga jos.

= Pentru a lua informatii despre marimea campului de
lupta si despre pozitia robotilor, se pot folosi

urmatoarele metode ale ale clasei Robot: ‘f;;ﬁ
o
Wt getBattleFieldHeight() - getX() _
getBattleFieldWidth() - getY() AR




Orientarea si manevrarea

= Cand unrobot se misca, el are o orientare.

Orientarea poate fi obtinuta prin apelarea metodei
"getHeading()” din cadrul clasei Robot.

Se poate obtine orientarea propriului robot, dar si cea a
altor roboti care au fost detectati cu radarul.
= QOrientarea este masurata in sensul acelor de
ceasornic de la 0° la 360°.
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2 Orientarea de 0° se obtine cand tancul este cu fatala
o
Y nord. ‘ 0°
.
270° P 90° 2
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Orientarea si manevrarea

* Manevrarea se poate face in intervalul [-180°,
180°].

= O manevrare de la 0° |la -180° va determina o
mutare stanga a robotului, iar intre 0° si 180° una
la dreapta.
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| Orientarea si manevrarea




Puterea si energia

= Distanta se masoara in pixeli. Cel mai mic camp
de lupta are 400x400 pixeli, iar cel mai mare

are 5000X5000.
* Fiecare robot are o energie de 100 la inceputul
jocului
Pierde energie in timpul jocului daca este lovit.
Castiga daca loveste alti roboti. =
= Puterea este cantitatea de energle pe Care o
G pune intr-un explozibil cand trage.

Cu cat lovitura este mai puternica, cu atat se 20
consuma mai multa energie. aiy
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Puterea si energia

= Dacaunrobottrage cu o putere de 2.5 in alt robot, din energie se
scade exact 2.5.

» Puterea poate lua valoriinintervalul [0.1, 3]

= Daca lovitura noastra (de putere p) loveste un robot inamic, energia
creste cu 3p.

» (Casavedem cata energie avem la momentul curent, apelam
metoda getEnergy() din clasa Robot.

= Atunci cand robotul nostru este lovit, energia sa scade dupa
urmatoarea formula:

energie = energie —4p, dacap <1 ‘{ET“:.
n. energie = energie — 4p —2 (p-1), daca1<p <3 ’
%™ Cand ne lovim de un alt robot, energia pierduta este de 0.6.
= Cand ne lovim de zid: s{i\;

= energie = energie — |v|/2 + 1, unde v este viteza.
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Alcatuire robot

» Fiecare robot are 3 componente:

Un radar

O tureta

Vehicul Orientare

. tureta
= Cele 3 partise -
N rientare

pOt MISCa vehicul
independent, \\ /

dar sunt montate
una deasupra
celeilalte.




Timp, viteza

Timpul se masoara in frame-uri.

Rata maxima de rotatie a armei (turetei) este de
20°/frame, a radarului de 45°/frame.

Radarul este montat pe arma, iar aceasta este montata
pe vehicul.

Daca se misca arma, se misca si radarul, iar daca se misca

vehiculul, se misca si arma cu radarul. =
"\l:‘

Ex: daca intoarcem arma la stanga si radarul la dreapta, acesta *
din urma se intoarce doar cu 45°-20°=25° |a dreapta. Pe de alta
.

parte, daca le intoarcem la dreapta pe amandoua, radarul se va o5
intoarce cu 45°+20°=65°. 5
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Timp, viteza

= Viteza unuirobot se obtine apeland metoda
getVelocity() pentru o instanta a clasei Robot.

Viteza poate fi doar in intervalul [-8, 8] pixeli/frame.
» Rata la care se poate intoarce un vehicul
depinde de viteza sa.

Avand o viteza v, rata de intoarcere (masurata in
grade/frame) este

t(v) =10—|v| * 3/4




Alte informatii utile

= Dupa foc, tureta se incinge si nu poate trage
un alt foc pana cand nu se raceste.

Cu cat puterea focului este mai mare, cu atat arma
se incalzeste mai tare

Inainte de a trage un foc, interogati daca arma
este fierbinte, ca sa fiti siguri de reusita.
» Radarul nu detecteaza explozibilul s
adversarilor.
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Clase

= Clasele pe care le poate mosteni un robot creat
de noi sunt Robot si AdvancedRobot.

Principalul avantaj al celei de a doua clase fata de
prima este ca permite rularea de mai multe procese in

paralel:
. )
Mutarea vehiculului
) _ ;.E_'ﬁ
Mutarearadarului  §  Concomitent! it

Mutarea turetel
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Crearea unul robot

package cs;
import robocode.*;

[****%  Robota - un robot al lui cs khkkk|
public class Robot1 extends Robot
{
//Aici se declara variabile
[FFxFFK run() defineste comportamentul robotului Robot1 *#*#*%*%*/
public void run()
{
//Cod ce se executa la inceput si o singura data
while(true)
{
/[Bucla infinita care determina comportamentul robotului =
} \ ma
o }
gﬁ;@f [/<Aici se scriu metode care spun ce sa faca robotul cand se intampla diverse evenimente
public void onScannedRobot(ScannedRobotEvent e) o
i 25
. Ve
fire(2); H'c
3




Crearea unul robot

2! Robot Editor
File Edit Compiler Window Help
4 Editing - C:\robocode\robots cs\Robotl . java

[

packadge cs3;

import robocode,®;

import java.awt.Color:

import java.awt.ewvent.MouseEwvent;

_I,-'*ﬂ'

* Robotl - a robot by cs

L
public class Robotl extends Robot
i
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* run: Robotl's default behawior
*/
public woid runi) {
getColors(Color.red,Color.blue,Color. green) ;
Jysten. out.println("Incepe batalial!!™):
while(true) {
/7 Beplace the next 4 lines with any behawior wou would like
ghead (100} ;
turnGunRight (360) ;
back (100 ;
turnGunRight (360) ;

BE BE RS B RS RS RS e e ek e e e e
RN W L0 P ek S M S0 =] SNy QN B L0

;’*1:

]
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¥ onfcannedRobot: What to do when you see another robot

*/

public woid ondcannedRobot (| 3cannedRobotEwvent ) {
fire(l):;

e e ke A
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Crearea unul robot

Robot Editor
File Edit Compiler Window Help

B Editing - C:\rebocode\robots\cs\Robotl java

32
33 i

34 # onHitEyBullet: What to do when vou'te hit by a bullet
35 * 4

36 public woid onHitByBullet(HitEyBulletEvent &) {

31 turnRight (e, getBearing ()]
38

39
40 public woid onWin(WinEvent e)

41 {

42 out.printlni " Te-an batut!™);

43 for {int i = 0; i < 507 i++)

44 {

45 setBodyColor(Color.yellow)
46 firej0.1);

11 turnRight(30) ;

48 turnLefr(30) ;

49
50
51
52
53 public woid onBulletMisszed(BulletMiszedEvent ewvent)

54 i

55 out.printlni”in trast la intamplare, iar energia mea este acum de
56
57
58

39 public woid onBulletHit{BulletHitEwent ewent)
111] {

e

+ getEnergy(] + ™!

61 dystem.out.println(”L-an lovit pe " + event.getWame() + " 51 energia lui este acuw de |z

62 zetBodyColor(Color.BLUE) ;
63

64
65 public woid onMouseEnteredMouseEvent e)

66 i

67 Svstem,out.println(™i intrat mouse-ul!™):
68
(1]

10 public woid onMouseExitced (MouseEvent e)

{
12 S¥stem.out.printlni”i iesit mouse-ul!™):
13

11

L 13




Robotul nostru la lupta

= Pentru lansarea consolei, se apasa butonul
indicat mai jos.

Robocode: Turn 259, Round 1 of 10, 19 TPS, 20 FPS
Battle Robot Options Help

nteractive

Fobot 1

|2 ie=it mouse-ul!
‘L-a- lovit pe sample.Interactive =i energia lui este

sample.Interactive si energia lui este
sample.Interactive =i energia lui este
sample.Interactive =i energia lui este -0t 112.0
sample.Interactive si energia lui este el

%L-n lovit pe sample.Interactive =i energia lui este -o! :'_..':

‘ Robot1

—_— —_——————— 76.0
“ OK H Clear H Kill Robot H Paint Robocode SG i Pause/Debug ’ 43_.3.

ra " Interactive
A intrat mouse-ul'"™);

ed (MouseEvent e)

"4 iesit mouse-ul!"™);

Pause/Debug |




Lista de clase si metode
folosite

= Din meniul Robocode, mergeti la “Help”-
>"Robocode API”.

= |In browserul care se deschide, vedeti in special
clasa "Robot” si metodele sale.

» Pentru a accesa API-ul Java, puteti accesa:
http://docs.oracle.com/javase/z/docs/api/ A&



http://docs.oracle.com/javase/7/docs/api/

Lista de clase si metode

folosite

void ahead(double distance)
Muta robotul inainte cu “distance” pixeli

void back(double distance) // inapoi
void fire(double power)

Trage cu explozibil cu puterea power din [0.1, 3.0]

double getEnergy()

Intoarce energia curenta a robotului

double getGunHeading()

Intoarce directia in care este indreptata tureta, in grade

double getHeading()

Intoarce directia vehiculuilui, in grade

double getRadarHeading() //acelasi lucru pt radar

double getX() // pozitia x a robotului
double

Ay )

A\


C:/robocode/javadoc/robocode/Robot.html
C:/robocode/javadoc/robocode/Robot.html
C:/robocode/javadoc/robocode/Robot.html
C:/robocode/javadoc/robocode/Robot.html
C:/robocode/javadoc/robocode/Robot.html
C:/robocode/javadoc/robocode/Robot.html
C:/robocode/javadoc/robocode/Robot.html
C:/robocode/javadoc/robocode/Robot.html
C:/robocode/javadoc/robocode/Robot.html

Lista de clase si metode
folosite

= void onBulletHit(BulletHitEvent event)
Metoda este apelata cand explozibilul loveste un tanc

= void onHitByBullet(HitByBulletEvent event)
Metoda este apelata cand robotul este lovit de explozibil

= void onHitWall(HitWallEvent event)
Cand se loveste de zid

= void onScannedRobot(ScannedRobotEvent event)

Cand radarul scaneaza un robot

= void turnGunLeft(double degrees)

Intoarce arma la stanga cu degrees grade.

&% = yoid turnLeft(double degrees)
Intoarce vehiculul la stanga cu degrees grade.

» void turnRadarlLeft(double degrees) // radarul

fan
‘ 4
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C:/robocode/javadoc/robocode/Robot.html
C:/robocode/javadoc/robocode/BulletHitEvent.html
C:/robocode/javadoc/robocode/Robot.html
C:/robocode/javadoc/robocode/HitByBulletEvent.html
C:/robocode/javadoc/robocode/Robot.html
C:/robocode/javadoc/robocode/HitWallEvent.html
C:/robocode/javadoc/robocode/Robot.html
C:/robocode/javadoc/robocode/ScannedRobotEvent.html
C:/robocode/javadoc/robocode/Robot.html
C:/robocode/javadoc/robocode/Robot.html
C:/robocode/javadoc/robocode/Robot.html

Editor.. Eclipse?

= Editorul pus la dispozitie de Robocode este bun,
poate si compila, dar mult mai util este Eclipse sau
NetBeans.
Ambele pot fi descarcate de pe Internet.
Eu prefer Eclipse. ©
Cautati “Eclipse IDE for Java Developers ”

= De ce sunt mai bune? Printre altele...

Compileaza in timp ce scrieti codul; G

Va ajuta prin afisarea tuturor metodelor unei clase atunci

cand puneti punct dupa instanta acelei clase. &5
Nu mai e nevoie sa rasfoiti documentatia... 2 iy

.\W{.
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http://www.eclipse.org/downloads/download.php?file=/technology/epp/downloads/release/ganymede/SR1/eclipse-java-ganymede-SR1-win32.zip

& Java - RobotNou/src/Cata/Catal.java - Eclipse Platform

File

Edit Source

Refactor MNavigate

COrHe s $-0-@Q
[# Package Explorer 2 =0

T AlgeritmiCulturali

|BEg|& ~

27 ClusteringPPSN
o7 ESVMs Fibro
7 ParticuleStol
7 PPSN
= RobotMou

8 src

8 Cata
[J] Catal java

=4 IRE System Library [jrel.5.0_16]
= Referenced Libraries

T Socoteli
7 SYNASC 2008
i Ksi0
5= Outline £2 =0
dHR e w7
B Cata

(c]

import declarations

s

robocode”

4—  java.awt.Color

4 java.awt.event.MouseEvent
Catal

@
@a
@a
@a
@a
@a
@a
@a

run()
onScannedRobot{ScannedRobotEw
onHitByBullet{HitByBulletEvent)
onWin{WinEvent)
onBulletMissed{BulletMissedEvent)
onBulletHit{BulletHitEvent)
onMouseEntered(MouseEvent)
onMouseExited(MouseEvent]

m 3

Search Project

v EHGCGT @2 &

Jacobe Run Window Help

EHr vt o -

[E parametersFile txt ] MyGamejava [J] *Catal java &3
package Catar
“import robocode.*;
import java.awt.Color;
import java.awt.event.MouseEvent;

* Robotl - a robot by Cata

puoblic class Catal extends Robot

Robotl's default behavior

= public void run() {

setColors (Color.rad,Color.blus, Color.green) »

System.out.println("Incepe batalia!!"™):

while (troe) {

/ Replace

ahead (100} ;
turnGunRight (360) 7
back (100}
turnGunRight (360) 7

1 see another robot

# onScannedRobot: What to do wt

= public void onScannedRobot (ScannedRobotEvent e) {
fire(l):

* onHitByBullet: What to do when re hit by a bullet

- B public void onHitByBullet (HitByBulletEvent e) {
turnRight (e.getBearing() )

-~ 2 public void onWin (WinEvent e)

{

<

[8_\ Problems @) Declaration | & Console 2

Mo consoles to display at this time.

Writable

Smart Insert

Robot Edrtor

£ cs.Robotl

12:38

& ava - Re

m

TEN ¢ ERET® &6 150
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Cum scrieti codul pentru un
robot 1n Eclipse

= Creati un nou proiect: File->New->Java Project

= |i dati un nume, apoi salvati.

Atentie, cand adaugati la proiect un fisier java, acesta
trebuie sa aiba acelasi nume cu clasa continuta in el (de
exemplu, clasa Robota va fi scrisa in fisierul Robot1.java)
= Mergetiin meniul Eclipse la Project->Properties-
>Java Build Path->Libraries->Add external JARSs siz&
2%, cautati Robocode.jar in locul unde ati instalat
& : . .
Robocode: daca ati pus chiar pe c:\, in o
c:\robocodel\libs. "



"

= Properties for RobotMou

type filter text Java Build Path

Resource

[# Source | 1= Projects | = Libraries % Order and Export
| I | |

Builders
Java Build Path JARs and class folders on the build path:
Java Code Style &, robocodejar - Chrobocode\libs Add JARs...

Java Compiler =i JRE System Library [jrel.5.0_16]
Java Editor Add External JARs...

Javadoc Location

Add Vanable...

Project References
Refactoring History Add Library...
Run/Debug Settings
Task Repository Add Class Folder...
Task Tags
Yalidation Edit...

Remowve

Migrate JAR File...




Cum scrieti codul pentru un
robot 1n Eclipse

Pentru a crea pachetul in Eclipse, mergeti in
c:\robocode\robots si mutati pachetul creat
acolo la inceput (cel care contine codul pentru
robotul personal si este referit prin initialele
date) in directorul workspace\Roboti\src in
directorul eclipse.

Compilati fisierul in Eclipse.

Lansati Robocode de pe desktop si mergeti in
meniul Options\Preferences\Development
options pentru a ii da calea catre clasa

generata acum de Eclipse. =)

it.
‘
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Rendering Options | Sound Options mon Oplions

Example: c:\edipsel

| Finish || Cancel

Main battle log

1] 5 10 15 20 25 30 40 50 &5 90 150 1000




Mal multe despre Robocode

» http://robocode.sourceforge.net/

Stiri, downloads, documentatii, forumuri,
competitii, clasamente etc.

» http://testwiki.roborumble.org/
Wikipedia despre Robocode.

" http://www.ibm.com/developerworks/java/lib &=§
rary/j-robocode/

= squ doar dati "Robocode” intr-un motor de i
,,.J“ 'y
cautare. il



http://robocode.sourceforge.net/
http://testwiki.roborumble.org/
http://www.ibm.com/developerworks/java/library/j-robocode/

